
 

s 

 
 

DESIGO™ RXT10.2 
Engineering and commissioning 
Quick guide 

 
 
 

 
 
CM110758en 
30.09.2005 

Building Technologies
Building Automation



2/32 

Building Technologies  CM110758en 
Building Automation  30.09.2005 

 
 
 

  



3/32 

Building Technologies DESIGO RXT10.2 Kurzanleitung CM110758en 
Building Automation Contents 30.09.2005 

Contents 
 

1 About this document ............................................ 5 

1.1 Before you start.................................................... 6 

2 Creating a new project (offline) ............................ 7 

2.1 Configuring the devices........................................ 7 
2.2 Creating bindings ................................................. 9 
2.3 Creating/modifying topologies.............................. 9 
2.4 Creating groups ................................................. 10 
2.5 Printing the project data, saving and closing the 

project ................................................................ 10 
2.6 Copying rooms................................................... 11 

3 Commissioning (online)...................................... 12 

3.1 Connecting the PC to the network ........................ 12 
3.2 Processing the “To do” list ................................. 12 
3.3 Loading the project data..................................... 13 
3.4 Disconnecting from the network......................... 13 
3.5 Commissioning a single device.......................... 14 

4 Service activities (online) ................................... 15 

4.1 Extending or modifying a project ........................ 15 
4.2 Resetting the project (Reset Project) ................. 16 
4.3 Replacing the master device.............................. 17 
4.4 Deleting a device................................................ 18 
4.5 Monitoring and diagnostics ................................ 18 

5 Integration into automation system (standard 
workflow)............................................................ 19 



4/32 

Building Technologies DESIGO RXT10.2 Quick guide CM110758en 
Building Automation Contents 30.09.2005 

5.1 INTEGRAL automation level with NITEL............ 19 
5.2 INTEGRAL automation level with NCRS............ 19 
5.3 UNIGYR automation level with NIDES.RX......... 20 
5.4 VISONIK automation level with NIDES.RX ........ 21 

6 Migration Utility .................................................. 22 

7 Dialog boxes and error handling ........................ 23 

7.1 Tool installation .................................................. 23 
7.2 Commissioning .................................................. 24 
7.3 Service errors..................................................... 27 
7.4 Special engineering notes.................................. 28 
 
 
 
 
 
 
 



5/32 

Building Technologies DESIGO RXT10.2 Quick guide CM110758en 
Building Automation About this document 30.09.2005 

1 About this document 
 

This condensed guide briefly describes the engineering and 
commissioning procedures for DESIGO RX projects. It 
covers both the activities to be carried out with the RXT10 
commissioning and service tool, and the steps required for 
integration into the DESIGO building automation and control 
system. 

The standard procedure for project engineering normally 
involves the use of the System Design component of 
DESIGO TOOLSET. In this case the RXT10 is used only for 
commissioning and service activities. 

Engineering 
workflow 
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1.1 Before you start 
 

This document is valid for the RXT10 commissioning and 
service tool from Version 2.3.  

The RXT commissioning and service tool is used to 
engineer, install and maintain LON networks incorporating 
DESIGO RXC and LONMARK-compliant third-party devices. 
This document contains basic information and operating 
instructions, and is written for engineering, commissioning 
and service specialists in the field of HVAC. 

All the tables have the same structure. The Action and 
Procedure columns are followed by a Menu column 
containing the command sequence. In addition to cross-
references within this document (chapter x.x), reference is 
also made to the relevant section of the User’s guide 
(CA110412en), where the procedures are described in 
more detail. 

Should you experience any faults or shortcomings in the 
product or the product literature, please contact the Common 
Support department of Siemens Building Technologies, 
Building Automation. This will help us further improve the 
product. 

Siemens Switzerland Ltd. Building Technologies Group  
Common Support Entry 5500 
Gubelstrasse 22 
6301 Zug, Switzerland 
Tel. +41 41 724 5500 
Fax +41 41 724 5501 
E-mail: fieldsupport-zug.ch.sbt@siemens.com 
 

Validity 

Content and 
target 
readership 

How the 
contents are 
structured 

Faulty product/ 
Incomplete 
documentation 

Support address 

mailto:fieldsupport-zug.ch.sbt@siemens.com
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2 Creating a new project 
(offline) 

 

Refer to Section 5 of the User’s guide. 

Action Step Procedure Menu Project > 
Set up project 1 Create a new project New 

2 Enter project name, engineer, 
and comments 

Properties >   
Overview tab 

3 Enter the project version General tab 
4 Select the relevant options Network tab 

Enter the project 
data 

5 Master device, network 
interface 

Integration tab 

 
• One project must be created for each PXR or NIDES.RX. 

• If you are using the same RXC devices in succession in 
different projects (for test purposes, for example), a 
different domain must be selected for each project. 

 

2.1 Configuring the devices 
 

Refer to Section 6 of the User’s guide. 

Action Step Procedure Menu Device > 
Register first device 1 Add a new device Add 

2 Location, description Summary tab 

3 Select application Application tab 

4 Select device type Device Type tab 

5 Set parameters Settings tab 

6 Save configuration OK 

Configure  
first device 

7 Select binding to  
master device 

 

1 Copy device Copy Register other  
identical devices 2 Paste device(s) Paste or  

Paste Special 

Notes 
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Action Step Procedure Menu Device > 
3 Modify location and description 

(and settings if required) 
Configure  
> Overview 
or  
Configure 
> List view 

4 Save configuration OK 

Register other  
dissimilar devices 

 As Step 1  

 
• Third-party devices from the applications library:  

same as RXC devices (application = 3rd party devices) 
• Third-party devices with LNS plug-ins (application type: 

LNS plug-in support) 
Devices can only be configured online. 

 

Notes on third-
party devices 
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2.2 Creating bindings 
 

Refer to the User’s guide, Sections 6.1.6 and 7. 

Action Step Procedure Menu View > 
1 Switch to the tree view 
2 Click source device or object 

and drag mouse pointer to 
target device or object. 

3 Binding template 

Create bindings 
between devices 

 It may be necessary to create a 
binding template if no suitable 
binding template exists already: 
Menu: Tools >  
Binding Template Editor 

Tree view 

 

2.3 Creating/modifying topologies 
 

Refer to the User’s guide, Section 6.10 to 6.12. 

Action Step Procedure Menu Tools > 
1 Open the relevant topology 

dialog box 
Device topology 
or 
Router topology…  

2 Adding segments Device topology > 
Create 

or Delete segment Device topology > 
Remove 

Define topology 
(offline) 

3 Highlight the segment, select 
device(s), and highlight new 
(target) segment 

Device topology > 
Move 

Modify topology 
(online) 

 Highlight the device 
placeholder 

Device topology > 
Move 

Create router 
topology (offline) 

1 Highlight router and highlight 
two new segments 

Router 
Topology… 



10/32 

Building Technologies DESIGO RXT10.2 Quick guide CM110758en 
Building Automation Creating a new project (offline) 30.09.2005 

Action Step Procedure Menu Tools > 
or Highlight the required 

segments 
Router 
Topology… 
> Change 

Reconfigure router 
topology 

2 Complete the reconfiguration 
process 

Router 
Topology… 
> Assign 

 

2.4 Creating groups 
 

Refer to Section 6.9 of the User’s guide. 

Useful for commissioning the plant; not to be confused with 
the Groups in the PXR). 

Action Step Procedure Menu: Tools > 
Group the devices 1 Display Group Editor  Group Editor...  

 

2.5 Printing the project data, saving 
and closing the project 

 

Refer to the User’s guide, Section 5.7 to 5.9. 

Action Step Procedure Menu: Project > 
Print the 
project data 

1 Select and print the required 
report type 

Print Report…  

Save the project 2 Save the project. (Files will be 
generated for system 
integration.) 

Save or  
Save as…  

Close the project 3 Close the project Close 
 
If you are ready to commission the RXC devices, you can 
now go to the "Commissioning" section, (see chapter 3) 
without closing the project. 

Note 
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2.6 Copying rooms 
 

Refer to Section 6.4 of the User’s guide. 

Action Step Procedure Menu:  
1 Register the first device, 

see chapter 2.1  
Register all the 
devices in a room 

2 Register remaining devices, 
as Step 1 

Device > Add 

3 Create bindings, see 
chapter 2.2  

View > Tree View Create bindings 
between registered 
devices 4 Highlight all the devices for this 

room and copy (including 
bindings) 

Device > Copy 

Copy room 5 Paste the copy once  
or more than once 

Device > Paste or 
> Paste Special 

Create bindings 
between rooms 

6 Create bindings between 
rooms, see chapter 2.2  

View > Tree View 
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3 Commissioning (online) 
3.1 Connecting the PC to the network 
 

Refer to Section 8 of the User’s guide. 

Action Step Procedure Menu: 
Connect the PC to 
the LON bus 

1 Check that the correct LON 
interface type has been 
specified. 

Tools > Options 

Activate the 
“To do” list 

2 Select the Show Todo dialog 
box on connection check box 

Tools > Options 

3 If there are routers on the 
network, specify the segment 
to which the RXT10 is 
connected.  

  

4 Connect to network Network > 
Connect 

 
If you make an incorrect choice here, it will not be possible to 
install the network. At a later stage during installation, errors 
will occur indicating an incorrect "channel". 

3.2 Processing the “To do” list 
 

RXT10 identifies outstanding tasks automatically. The “Todo” 
list appears as soon as you select Network > Connect.  The 
check boxes marked with a cross indicate those items in the 
network which still need to be modified or installed. Click 
Process to start the first step.  

These steps correspond to the steps in the basic 
“Commissioning” procedure. 

 
 

Important 
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3.3  Loading the project data 
 

Refer to Section 8.4 of the User’s guide. 

Action Step Procedure Menu: Network 
1 Select the devices to be 

installed 
3 Load Settings 
4 Set Device Online 

> Install…  Install the devices 
with the following 
options: 

5 Update application Device > 
Configure… 
> Application > 
Settings 

 
Both the installation of the master device and the loading of 
project data can be automated by use of the Connect 
Wizard. 
 

3.4 Disconnecting from the network 
 

Refer to Section 8.10 of the User’s guide. 

Action Step Procedure Menu:  
1 Disconnect from network Network, 

Disconnect 
 

2 Select and print the required 
reports 

Project 
> Print Report…  

 

Note 
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3.5 Commissioning a single device 
 

Refer to Section 8.5 of the User’s guide. 

Action Step Procedure Menu:  
1 Connect the PC to the RXC 

device 
 

2 Connect to network Network > 
Connect 

Install devices 

3 Select device from the list view View  
> List View 

4 Assign address 
5 Load settings 
6 Set device online 

Device 
> Install... 

Define options 

7 Disconnect from network Network 
> Disconnect 

 
 
For a detailed description, refer to Section 8.6 of the User’s 
guide. 

Third-party 
devices with 
LNS plug-in 
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4 Service activities (online) 
 

Refer to Section 9 of the User’s guide. 

4.1 Extending or modifying a project 
 

Action Step Procedure Menu:  
1 Disconnect the RXT10 from the 

network 
Network 
> Disconnect 

2 Add device(s) Device > Add 
3 Connect to network Network 

> Connect 
4 Address the new devices Network > Assign 

devices. 
 

Add device(s) 

5 Install the new devices  Network  
> Install... 
> Select Changed 
Devices 

6 Connect to network Network 
> Connect 

Replace device 

7 Replace device Device > Replace 
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4.2 Resetting the project 
(Reset Project) 

 

Refer to Section 5.10 of the User’s guide. 

In the event of a problem, it is possible to reset the devices in 
a project, i.e. restore their default values. 

Resetting a project has significant consequences for any 
devices which have already been addressed. These devices 
must be reinstalled to maintain the consistency of the 
network. Projects should therefore only be reset in extreme 
circumstances.  

Make sure you create a backup first (see the User’s guide, 
Section 5.8). 

Action Step Procedure Menu:  
Save the project 1 Create a backup Project > Backup 
Disconnect from 
network 

2 Disconnect from network Network 
> Disconnect 

3 Reset the project (deletes LNS 
database) 

Reset project 
Important:  

4 If the assignment is correct, 
answer No to the prompt 
Delete Neuron ID? 

Project  
> Reset… 

De-energize PXR Use reset button 
(do NOT remove battery!) 

De-energize 
NIDES.RX 

5 

Remove battery for min.10 s 

 

6 Connect to network Connect to network 
7 Answer No to the prompt 

Install MD? 
(to save time, do not install MD 
until later) 

Network > 
> Connect 

Reinstall devices 8 Re-install devices (without 
Application download) 

Network 
> Install … 

Disconnect from 
network 

9 Disconnect from network Network 
> Disconnect 

STOP

 
 

Caution 
 

Note 
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Action Step Procedure Menu:  
Save the project 10 Save the project Project  

> Save…  
Connect to network 11 Connect to network Network > 

> Connect… 
Install master 
device 

12 Install master device Device 
> Install… 

Read network 
status 

13 Read network status Network > Get 
status 

Disconnect from 
network 

14 Disconnect from network Network 
> Disconnect 

Save the project  Save the project Project  
> Save…  

 

4.3 Replacing the master device 
 

Refer to Section 6.7 of the User’s guide. 

Action Step Procedure Menu:  
Disconnect from 
network 

1 Disconnect from network Network 
> Disconnect 

Delete master 
device 

2 Delete master device from 
database 

Tools > Clear MD 
image 

Reset new 
master device 
(NIDES.RX only) 

3 Remove battery for approx. 10 
seconds 

 

Replace device 4 Replace master device  
Connect to network 5 Connect to network Network 

> Connect 
Install master 
device 

6 Install master device Device 
> Install… 

 
For technical reasons, the RXC devices are reset twice upon 
connection to the network. This can affect lighting and blinds 
(depending on the controller settings). 

 

 
Important  
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4.4 Deleting a device 
 

This process deletes existing bindings. The device must also 
be deleted at the automation level and the management 
level. 

4.5 Monitoring and diagnostics 
 

Refer to Section 9.1 of the User’s guide. 

The Commissioning Support option is an efficient tool for 
commissioning and maintenance of DESIGO RXC systems. 
The following processes can be carried out for several RXC 
devices at once: 

• Monitor process values 
• Override outputs 
• Modify settings 
 

Action Step Procedure Menu:  
1 Connect the PC to the LON 

bus 
 

2 Connect to network Network 
> Connect 

3 Display commissioning support Tools, 
> Commissioning 
support… 

4 Select devices  
5 View process values. Select 

the View check box. 
 

6 Override outputs: 
select the Override check box. 

 

7 Change settings: click Settings  

Connect to network 

8 Disconnect from network Network 
> Disconnect 

 
Remember to reset the devices to "Auto" before closing the 
Commissioning Support dialog box. 

 

Notes: 

Note 
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5 Integration into 
automation system 
(standard workflow) 

 

Refer to the online-help in DESIGO TOOLSET. 

5.1 INTEGRAL automation level 
with NITEL 

 

Action Step Procedure Tool 
Download Infolist 
and text into 
NIDES.RX 

1 Download the Infolist and 
Split.asc file 

DESIGO INSIGHT 
CA1Z9125 

Import database 2 DB Import: import the 
Split.asc file  

DESIGO INSIGHT 
CA1Z9125 

Graphics 
engineering 

3 Integrate genies and 
super genies 

DESIGO INSIGHT 
CA1Z9130 

    

5.2 INTEGRAL automation level with 
NCRS 

 

Action Step Procedure Tool 
1 Read the NIOPEN.ASC and 

SAPIM.ASC files into 
INTEGRAL PLAN 

INTEGRAL PLAN 
Folder M3 

Generate NCRS 
database from 
SAPIM.ASC and 
NIOPEN.ASC 2 Create the NCRS database 

and Infolist 
e.g.  (sta_ncrs.dbs) 

INTEGRAL PLAN 
Folder M3 

Load NCRS 
database 

3 Database >  Restore  
(sta_ncrs.dbs) 

NCRS Access 
CA1Z9125 

Load Infolist into 
NIDES.RX 

4 Database > NICO Infolist 
(infolst1.inf) 

NCRS Access 
CA1Z9125 

For DESIGO PX 
automation 
level with PXR 
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Database import 5 Import sta_ncrs.dbs  DESIGO INSIGHT 
CA1Z9125 

Graphics 
engineering 

6 Integrate genies and 
super genies 

DESIGO INSIGHT 
CA1Z9130 

    

5.3 UNIGYR automation level with 
NIDES.RX 

 

Action Step Procedure Tool 
1 Import 

NIOPEN.ASC 
2 Generate UNIGYR function 

blocks and set parameters 

Create RXC 
configuration 

3 Update user manual 

UNIGYR Design 

Download to 
RX master 

4 Configuration including 
transmission of the  
NIDES Infolist 

UNIGYR Tools 
CA2Z3299 
CM2Z8021 

Download to 
NIDES.RX 

5 Transmit Infolist Automatic if 
different from the 
last loaded version 
CA2Z3299 
CM2Z8021 

Database import 6 UNIGYR DB Import TagTool 
CA1Y9122 

Graphics 
engineering 

7 Integrate genies and 
super genies 

DESIGO INSIGHT 
CA1Z9130 

 
Do not create a binding between NIDES.RX and RX master 
until the commissioning on the LON side is complete. 

Note 
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5.4 VISONIK automation level with 
NIDES.RX 

 

Action Step Procedure Tool 
 The following files are created: 

1 “Project data” 
2 "NIOPEN.ASC" 

Create RXC project

3 "RxNiBps.COL", containing: 
– TSK111.TXT  

(project image for BPS) 
– TSK110.TXT 

(Infolist for NIDES.RX) 

RXT10  
CA110412 

Define groups 4 Adapt GroupConfig.COL  
manually to the project 

VISOTOOL 
CA2Z8339 

5 Download RX coupling (CFE 
application) to the BPS. 

General VISONIK 
engineering 

6 Carry out general VISONIK 
engineering 

VISOTOOL Editor 
CA2Z8339 

Database import 7 DB Import: Import global and 
project-specific data 

DESIGO INSIGHT 
CA1Z9125 

Graphics 
engineering 

8 Integrate genies and 
super genies 

DESIGO INSIGHT 
CA1Z9130 

 
Do not create a binding between NIDES.RX and 
VISONIK BPS until commissioning on the LON side is 
complete. 

Note 



22/32 

Building Technologies DESIGO RXT10.2 Quick guide CM110758en 
Building Automation Migration Utility 30.09.2005 

6 Migration Utility  
 

Refer to Section 10 of the User’s guide. 

Action Step Procedure Menu:  
1 Open old v1.x project in the DESIGO RXT10.2 V2.3 

engineering tool 
2 Use the report function to save or print full device 

details 
3 Save the project and close it, do not make any other 

changes at this point. 
4 Create a new empty project using the v2.x library in 

the DESIGO RXT10.2 engineering tool.  
This should just include the desired master device 
and no other controllers or devices. 

5 Save this new project using a different name and 
location to the original. 

6 Start the ‘Migration Utility’ from the tools menu, and 
select the project to be migrated. 

7 Make a note of any errors or changes indicated by 
the utility. 

8 Save the project. 
9 Check all configuration details and bindings with the 

report generated previously to ensure all details are 
correct. 

10 Install the NIDES.RX interface. 

11 Install all devices 

Migration Steps 

12 Save the project 
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7 Dialog boxes and 
error handling 

 

For online help in the RXT10, press <F1> in the error view. 

7.1 Tool installation 
 

Message Cause Action 
The path entered under 
System properties 
> Environment  
is not correct 

OK  
Complete the  
System properties 
> Environment path: 
C:\Lonworks\Bin  

The files NMSndMsg.ocx 
and LNS_FTP.ocx are 
not in the registry 

Register NMSndMsg.ocx 
and LNS_FTP.ocx with 
regsvr32. DOS 
command:  
regsvr32 NMSndMsg.ocx 
regsvr32 LNS_FTP.ocx 

The system is not 
installed correctly. Please 
add the directory 
LonWorks\Bin to your 
“Path” environment 
variable and restart the 
computer. 

 

LNS not installed Check whether the LNS 
software is installed 
under Control panel > 
Add/Remove programs 

 

Note 
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7.2 Commissioning 
 

Message Cause Action 
RXT cannot connect: the 
network interface is being 
used by xxx 

The LON network 
interface is being used by 
another user.  

Please wait until the 
other application has 
finished using the 
network interface. 

No object selected For networks with several 
segments, you need to 
specify the segment to 
which the tool is 
connected. 

OK 
Select segment. If no 
segment is selected, the 
connection will be 
terminated. 

Could not open project 
file. Make sure the file is 
not being used by 
another application. 

The project file has been 
opened by another tool 
(e.g. MS Access) 

OK 
Close the program which 
opened the project file. 

The project has been 
reset 

Confirm with YES There is already a 
binding to this project, but 
the LNS database is 
missing. Do you want to 
create a new database? 

Instead of creating a 
backup of the project, 
only the project file was 
copied. 

No 
Obtain a backup copy 
and use this project. New 
> Connect. 

Master device has a bad 
magic key. Are you sure 
you want to continue? 

The checksum in the MD 
does not match the one 
in the project. The MD is 
corrupt, or there is 
another user working with 
the project 

Yes / No  
Ensure that this is the 
current project 

Update MD or 
Clear MD image 

Invalid Private data file 
Are you sure you want to 
continue? 

The data in the MD does 
not match the project; 

Yes / No  
Re-install MD  
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Message Cause Action 
Timestamp mismatch!  
Are you sure you want to 
continue? 
(Update master device 
with selected project?) 

The project was not 
saved after the last 
connection.  

Old backup. The MD has 
since been changed. 

Yes: loading current 
project into MD.  

NO: Establishing 
connection without 
updating the MD.  

Cancel: Connection 
terminated 

Validation found that MD 
data is inconsistent with 
device with module No. 
xxx. Do you want to try to 
update the MD with the 
available data? 

If the response to the 
Incorrect time-stamp 
error was Yes, the 
modules being updated 
are displayed. 

Yes / No  
Yes to update MD 

The device with 
NeuronID xxx is already 
in this project. Please 
select a new device. 

An attempt is being made 
to install a device which 
already exists in the 
project database. 

OK 
Check that the correct 
device is being installed 

Cannot communicate 
with Master Device! 

– Check the cable, 
power supply and 
battery.  

– MD busy, no 
response, cable not 
plugged in correctly.  

– Wrong project. 
– Bus problems (bus 

overload, termination 
resistance, bus 
connector with loose 
contact etc.) 

Abort / Retry / Ignore 
Check for all the 
suggested causes 

No project information 
found in the master 
device. The master 
device is not installed or 
there is a communication 
problem. 

Power failure with faulty 
battery 

Abort / Retry / Ignore 
Check the power supply 
and the battery. Re-install 
the master device. 
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Message Cause Action 
xxx devices are 
integrated into this 
project, but you can only 
integrate yyy devices with 
the selected master 
device. 

The new master device 
you have selected (PXR) 
cannot accommodate the 
number of devices 
already set up (change 
from PXR12 to PXR11). 

OK 
Integrate fewer devices 
or select PXR12 as the 
master device 

Could not save project 
under C:\xx 

The project is write-
protected because it was 
copied from a CD. 

OK 
Remove the 
write-protection from the 
project file. 

Could not open LNS 
network and/or system. 
Invalid parameter values 
(subsystem: NS, 44#) 

LNS will not enable the 
file “db”. 

OK  
Save project 

Important: 
Reboot the RXT tool. 
(LNS will enable the data 
after the next restart).  
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7.3 Service errors 
 

Message Cause Action 
Replace device:  
Error preparing to replace 
device 

Could not initialize the 
new device to be 
replaced. 

OK 
Initialize the device in a 
test project, to check 
basic operation. Check 
the cable. 

Error replacing device! Could not download 
settings into new device.  

OK 
Repeat the process. 
If this does not help: Test 
the device by 
commissioning it in a 
separate project (function 
test) 

 The new device could not 
be registered in the 
master device. 

OK 
Check the master device 
and then repeat the 
process. 

No network interface 
selected! Are you sure 
you want to continue 
without a network 
connection? 

No network interface 
selected in the Tools > 
Options menu. 

Yes / No 
This may be intentional 
(to reduce waiting time on 
the site).  
If not, select the network 
interface under Tools > 
Options. 

Do you want to read the 
device information from 
the network? 

When re-installing the 
MD, the device data 
needed by the master 
device can be read from 
the network or from the 
database.  

Yes / No 
Read from network: The 
database will be updated 
again.  

Reading from the 
database is faster. 

The project has been 
updated from a previous 
version. If you save the 
project now, you may not 
be able to open it with the 

 OK 
To keep the old project, 
save the new project 
under a new name. 
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Message Cause Action 
old version of the tool. 

Do you want to append 
data to xxx? 

Network test 
 > Backup. If you click 
Cancel, you will be asked 
for a new file name. 

Yes / No / Cancel 
If you choose not to 
append the new data, 
then the old data in the 
file will be overwritten. 

 

7.4 Special engineering notes 
 

Message Cause Action 

A template named "xxx" 
already exists. If you 
overwrite this template, 
the changes you made 
will apply to ALL bindings 
made with this template. 
Do you want to overwrite 
it? 

Warning! Existing 
bindings will also be 
changed. 

Yes / No 

Rename the binding if 
there is any doubt as to 
whether or not this 
binding is already being 
used. 

No space for xxx  more 
device(s). 

Paste special:  
More than 150 devices 
have been created. 

OK 
Create fewer devices, or 

create a second project 

Network interface xxx not 
found! Cannot connect. 
Do you want to continue 
preparing the database? 

A network interface 
previously installed on 
this computer is no longer 
present. 

OK / Cancel  
Select or install a new 
network interface 

Master device limits 
exceeded (xxx > yyy data 
points). 

Only 889 data points are 
allowed 

(total 900 data points, of 
which 11 reserved for 
NIDES-RX). 

OK 
Modify binding template; 

Use fewer network 
variables; 

Use fewer devices; 

 Create a second project. 
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Message Cause Action 

Device xxx has more 
than yyy network 
variables bound  to the 
master device!  

More than 25 network 
variables per binding 
template (or several 
binding templates 
between device and 
master device). 

OK 
Modify binding template. 

Project validation failed! 
You may have loaded the 
wrong database, or are 
not properly connected to 
the network. If you are 
absolutely sure that  the 
right database is loaded, 
click Yes. Otherwise click 
No. 

The data in the master 
device does not match 
the data in the open 
project: 

An old version of the 
project is open, or the 
project was modified on 
another PC. 

Yes / No 
If you are sure you are 
working with the right 
project, click YES to 
update the master 
device.  
Clicking NO terminates 
the network connection. 

One or more remote 
servers have been found. 

More than one LNS-
based tool is connected 
to the network. 

OK 
Check that only one 
LNS-based tool is 
connected to the network. 

The master device 
cannot be the source for 
a binding. 

Tree view: 
Master device is marked 
as source 

OK 
Draw binding from RXC 
device to master device 
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Message Cause Action 

The locations are not 
unique. Deleting 
integration files! 

Locations do not have 
unique definitions, or 
syntax is faulty. 

Note: Unique location 
strings are only required 
with VISONIK. The check 
for unique strings can be 
disabled in the Options 
menu.) 

OK 
Enter unique locations. 

Some devices/routers 
have been marked in 
preparation for a move, 
but have not been 
moved. Do you still want 
to disconnect from the 
network? 

In the engineering 
process, devices were 
moved to other 
segments, or segments 
were linked to other 
routers.  

Yes / No 
These changes must also 
be carried out in the 
network. If you 
disconnect from the 
network now, the 
changes prepared will not 
be carried out. 
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